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1. Main Tasks 

The tasks of the Data Concentrator Telem-GW6 (GW6) include the following: 
• To control and monitor the system from the control center using data 

communication protocols IEC 60870-5-101 and IEC 60870-5-104 
• To concentrate data collection from lower level peripheral devices and 

control them by using different data exchange protocols 
 
2. Possible Applications 
 
• Data acquisition and control of regional and national electricity utilities in 

SCADA systems for remote control and substation automation 
• Comprehensive integration of different devices  
• As a communication gateway 

  
3. Features 
 

• Telem-GW6 base model includes basic card with built-in communication 
ports 

• Expansion card 1 and 2 are optional extras (see 5. Technical Data) 
• Data concentrator with an associated event annunciator performing sub-

station level master unit functions in the substation secondary equipment 
system 

• Duplex data communications between the feeder and the equipment level 
versus the station control level in substations using different 
communication protocols and cross-referencing between the protocols 

• Full scale data exchange between the levels of the substation control 
system including setting values, measurement values, registered fault 
parameter values, changes of state with associated time markings etc 

• Data concentrator provided with serial interfaces to facilitate the 
connection between local output devices and external host systems 

• All the settings can be changed using software configuration tool 
• Output channel to the remote control system can be connected to a leased 

or a dial-up line using a copper line-, radio- or GSM modem 
• Data concentrator GW6 is provided with control input for clock 

synchronizing purposes using GPS 
• GW6 time synchronization by communication protocol (IEC 6870-5-101, 

IEC 6870-5-104) from control center’s channels (GW6 time 
synchronization is possible from multiple control centers) 

• Time synchronization of substation devices by communication protocol 
(IEC 6870-5-101, IEC 6870-5-103) 

• Time synchronization by SNTP protocol (on Ethernet connection) 
• Logical operations between digital and analog signals can be described 
• PLC logic support, configuration tool with integrated PLC editor in 

compliance with IEC-61131-3 standard 
• TELEM RTU devices can be remotely configured across Telem-GW6 
• Configuration export to ASCII, CSV format files 
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• A user-friendly user interface similar to MS 
• Collects and transfers the sequence of events (SOE) with 1 ms accuracy 
• Data sending with time and quality stamp 
 
 
4. View 
 
 

 
 
Figure 4   Telem-GW6 view 
 
5. Technical Data 
 
Data communication protocols 
• To higher  level systems IEC 60870-5-101 unbalanced and balanced,  IEC 

60870-5-104 
• To lower level devices IEC 61850, IEC 60870-5-104, IEC 60870-5-103, 

IEC 60870-5-101 Unbalanced, SPA-bus, IEC 62056-21 (IEC 1107), 
Modbus-RTU, DNP 3.0 
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Communication ports 
Communication ports may be freely configured for upper or lower level 
communication 
 
Built-in 

• 1x Ethernet connection with RJ45 connector 
• 1x RS-232 full modem serial connection with RJ45 connector 
• 1x RS-422 serial connection with RJ45 connector 
• 1x USB connection with Type B connector 

 
Expansion card 1 

• 1x Fiber-optic connection with ST or Versalink connectors 
• 1x RS-232 with RTS, CTS handshake signal serial connection with 

RJ45 optically isolated connector 
• 1x RS-485 serial connection with RJ45 optically isolated connector 
• 1x GPS Fiber-optic connection with Versalink connector 

 
Expansion card 2 

• 8x RS-232 serial connections with RJ45 connectors 
 
 
Data communication parameters 

• 1 start bit 
• Odd, even or no parity 
• Communication rates from 300 to 115200 bit/sec 
• Configurable RTS/CTS handshake for all RS-232 ports. 

 
Electrical characteristics of isolated input 

• Dielectric withstand     IEC 60255-5 
• Withstand to static discharge   IEC 61000-4-2 
• Withstand to surges, bursts   IEC 61000-4-4, 61000-4-5 

 
Mechanical parameters 

• Degree of protection    IP 32 
• Dimensions (W x H x D)   ~ 84 x 107 x 164 
• Ambient temperature in operation  –20…+50°C 
• Weight     ~ 1kg 
• Mounting     DIN rail 

 
Power supply 

• Supply voltage range    10 to 32 V DC 
• Power consumption    < 8 VA 
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6. Typical Application for Electric Power Station 
 

  

7. Switches  
 
 
 

 
1 – Reset: Switch RESET to ON state and then back to OFF state for Reset 

operation 
2 – Dft. Set: To apply default setup: 
 

1. Switch DFT. SET to ON state 
*Alert indication LED starts blinking within 5 seconds 
*Alert indication LED will blink for 2 seconds 

2. Switch DFT. SET back to OFF state when the alert indication LED is 
blinking  to apply default setup 
*If DFT. SET is switched back to OFF state when the alert indication 
LED is not blinking, default setup will NOT be applied 

 
8. Indication 
 
For operation 
Green LED – Blinking green indicates that the program is running  
Red LED – Failure 
 
For communication 
Yellow LED – RX 
Green LED – TX 

  Green LED at GPS port – blinking indicates the existence of GPS time 
synchronization.  

R
es

et
 

D
ft.

 s
et
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9. Remote monitoring of operation 
 
The status and operation of the device can be examined from log files. 
The log files can be accessed via built in Web interface or can be downloaded 
via FTP connection. 
The status information is recorded in status log files and the events archive is 
retained in events log files. 
 
 
9.1 Status log 
 
Detected status changes and errors are stored in text files and are physically 
saved to device’s flash memory. 
The following information is recorded: 

- The communication breaks and recoveries with substation 
equipment 

- Starts 
- Watchdog operations 
- Software error messages 
- Communication ports failures 
- TCP/P channels open and close operations, failures 

 
Last errors reside in file Errors.txt, which can grow up to 500 kB in size (about 
10 000 errors). On growing over this limit the Errors.txt is renamed to 
Errors.NNN, where the NNN is file no. and the new Errors.txt starts to grow 
from zero again. 
These files can be retrieved over the FTP connection: 
ftp://[ip address]/errors 
 
 
 
9.2 Events archiving 
 
Sequence of events (SOE) are collected with 1 ms time resolution. These 
events are archived in the form of text files and are physically saved to 
device’s flash memory. Events log will be updated only if any events occur. If 
no events are detected, nothing will be written to events text file. 
 
Last events reside in file Events.txt, which can grow up to 500 kB in size 
(about 10 000 events). On growing over this limit the Events.txt is renamed to 
Events.NNN, where the NNN is file no. and the new Events.txt starts to grow 
from zero again. 
Events.NNN is also copied to Events.bak , previous Events.bak is overwritten. 
The contents of Events.txt and Events.bak is viewable in Web Browser. 
 
Events.NNN files are stored in compressed form in  Events.bz2, which can 
grow up to 4 MB, after that the older files inside Events.bz2  will be deleted. 
All these files can be retrieved over FTP connection. 
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Archive includes: 
- Events.txt 
- Events.bak 

 
- Compressed container Events.bz2: 

 
 
 
 
 
 
 
 
 
These files can be retrieved over the FTP connection: 
ftp://[ip address]/events 
 
 
 

Events.001 
. 
. 
. 
Events.NNN 
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10. GW6 Configuration Tool 
 
10.1 Getting Started 
 
Configuration program works on Windows operating systems. When starting 
the GW6 configuration program, user interface window with the main menu is 
opened: 
 

 
 
Figure 10. 1.1 User interface window 
 
The following parameters are shown for information:  
• Port  – PC port which is used to communicate with GW6  
• Link address  – Link address of GW6 
• ASDU address  – ASDU address of GW6 
• Status – Status of the connection. RED – no connection, GREEN – 

connection OK 
 
Device menu 
• Device – For selecting the device type 
• Communication Setup - For changing communication parameters (figure 

10.1.2) 
• GW6/RTA-A conf redirection  – see 10.5 Configuration of connected I/O 

modules remotely through the GW6 
 

 
 
Figure 10.1.2. Communication parameters window 
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Fields in the communication parameters window 
 
• Port  – PC communication port which is used to communicate with GW6  
• GW6 USB Interface  – Check if USB port is used for communication 
• Baud rate  – Data communication rate 
• Parity  – Use of parity control bit  
• Flow control  – Determines whether the RTS/CTS handshaking is used  

• Communication delay  – Delay between reception of data and the next 
query in milliseconds  

• Link address  – Link address of GW6 
• ASDU address  – ASDUI address of GW6  
• ASDU address length  – The length of the ASDU address in bytes: 

typically 2, possible values are 1 or 2. 
• Object address length  – Length in bytes. Typically 2, possible values are 

1, 2 or 3.  
 
 

 
 
Figure 10.1.3. GW6/RTA-A conf redirection window 
 
• Device no  – Number of the device which is configured (see 10.3.2 

Devices Tab Card) 
• Activate/Deactivate  – Activate to configure the desired device; Deactivate 

to configure GW6 
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10.2 GW6 Configuration Window 
  
To open the GW6 configuration window, select Device > GW6  from the user 
interface main menu. 
 
Shortcut icons  below the menu bar:  
 

 Open a new configuration 

 Open a configuration file 

 Save the configuration to a file 

 Read the configuration from GW6 

 Write the configuration to GW6 

 *Reset GW6 

 Load XML file (IEC 61850) 

 Reload all XML files attached to devices (IEC 61850) 
 
 * Possible Reset codes: 
 1 – Simple Reset 
 2 – Reset that also clears memory buffers 
 3 – Reset that also restores the default setup 
 
Saving, editing and opening configuration data 
 
Configuration data is saved to the hard disk in the form of comma separated 
files*.CSV files when the Save or Save As  command is chosen from the File 
menu. Correspondingly, the Open  command from the File menu opens this 
type of file. Open  and Save can also be accessed via shortcut icons. 
*.CSV files can be conveniently edited with Excel software or even with the 
Note Pad program. When editing the configuration with Excel, the file has to 
be saved as a comma separated CSV file.  
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Table of configuration window menu items 
 

Main menu File Common Help 

Submenu 
(Shortcut key) 

New  (Ctrl+N) Read 
Configuration 

Help  (F1) 

Open(Ctrl+O) Write 
Configuration 

About 

Save (Ctrl+S) Cancel Active 
Transfer 

 

Save As Send Reset 

Exit 
Analog 
Groups 

 

Tcp/Ip 
Settings 

Time Settings 

Modem 
Settings 

Port Mirroring 

Options 

 
 
 
10.3 Tab Cards in the Configuration Window 
 
Configuration and setting parameters can be utilized by using topic tab cards:  
Ports, Devices, Objects, Formulas, Status. 
A click on a tab card button switches between tab cards.  
 
Using the grid area 
Parameters can be selected or changed in the grid area cells. Values of some 
cells can be changed directly and those of others via a list box or a popup 
window. 
 
Values of the same column can be copied to clipboard. Use a left mouse click 
together with the Shift key to copy and a left mouse click together with the Ctrl 
key for paste operation. 
 
Status message in the bottom left corner of the window shows the result of the 
last data modification action (OK, Error, etc). 
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10.3.1 Ports Tab Card  
 
Ports tab card  is active when the GW6 configuration window is opened. 
 

 
 
Figure 10.3 .1 Configuration window with Ports configuration tab card. 
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Configuration parameters of a port: 
• Protocol  – Communication protocol used by all the devices of this port. 

Each protocol name is accompanied with a symbol l”^” or  ”ν ” which 
indicates whether the port is used for an uplink or a downlink channel. For 
example, “Modbus ν” means that this port is used for downlink with  
Modbus protocol. 

• Baud rate  – Data communication rate  
• Parity  – Use of parity bit for all the devices on this channel 
• Stop Bit  – possible values are 1, 2 
• Data Bits – possible values are 7, 8 
• Communication Mode  – Makes it possible to choose between the 

following handshaking options: 
 - No control 
 - Modem Callout – Port 2 
 - RTS/CTS  Control – Port 2 
 - RS-485 – Port 5 
 - Tcp/IP – Beginning from Port 14 

• IP address – communication IP address (used if Communication Mode is 
set to Tcp/IP) 
a) 61850 v 

 
Port (RFC 1006)  – IEC 61850 port of 
ISO Transport on top of TCP 
IED IP Address  – an IP address of the 
61850 device (server) 
Provider IP Address  – additional IP 
address of GW6 
Provider Port – TCP port of  IEC 
61850 provider 
 
 
 

b) IEC ^ or IEC v  
 
Other’s side IP Address  – an address 
of the device which can connect with 
GW6 using corresponding port (if set to 
0.0.0.0 – all devices can connect) 
Additional IP Address  – additional IP 
address of GW6 
Port – available network 
communication port (in case of IEC 
60870-5-104 protocol, port 2404 is 
recommended) 
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* If 2 or more different IP addresses are needed (for connecting to multiple 
networks [IEC 60870-5-101, IEC 60870-5-104] or to multiple devices [IEC 
61850], then it is necessary to add equal number of ports and to define a 
different IP address to each port. Port 14 and higher all use the same 
physical Ethernet port. 

• Polling(v)/Answering(^) Delay  – Delay between reception and the next 
query  

• Port Link Address  – Link address of the device on uplink channels 
• IEC ASDU Address  – ASDU address on uplink channels 
• Length of the ASDU Address  – Length of the ASDU address in bytes on 

uplink channels. Typically 2, possible values are 1 or 2 
• IEC Object Length  – Length of the IEC object address in bytes on uplink 

channels. Typically 2, possible values are 1, 2  
• Up Protocol Subversion  – Number of protocol subversion on uplink 

channels 
• Query Timeout [ms] – Query timeout for devices on downlink channels 
• Failed Query Count for disabling contr.  – Count of timeouts after which 

the error flag is raised and the query of this device temporarily suspended  
• Query Interval for Retry/Bal.mode [s] – Time period after which the 

suspended device is queried again 
• Suppress Echo – If the sent messages are echoed back by the 

connected devices then they need to be suppressed  
• Replace Event hrs – Yes/No. If Yes, events are sent to control centre with 

UCT time (the time correction value is set in Common Menu, Timing 
Settings) 

• Time – Determines the time tag of events 
• Control takeover DO obj.addr. – The address of an object that 

determines control takeover of that device 
*the object must be determined under a virtual device in objects table 

• Control takeover DI obj.addr. –  The address of an object that shows 
which channel has taken over the control rights 
*the object must be determined under a virtual device in objects table 
 

  



AS Martem                          Data Concentrator TELEM-GW6  User Manual Rev. 7 / 2010 
 

 
Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.eu 
12618 Tallinn                                  Fax: +379 639 79 80                                                 www.martem.eu 
Estonia 
 - 16 - 

10.3.2 Devices Tab Card  
 

 
 
Figure 10.3.2. Devices tab card 
 
Parameters: 
• Device nr – Sequence number of the device 
• Objects  – Number of objects in the device  
• Link address – Link address of the connected device 
• ASDU address – ASDU address of the connected device 
• ASDU address length  – Length in bytes, possible values are 1 or 2  
• Object address length  – Length in bytes, possible values are 1, 2 or 3 
• In use  – Indicates whether the device is in use or not. If the device is not in 

use, the whole row has a grey background  
• Port  – Port no. of GW6 to which the device is connected 
• Protocol Subversion – Number of protocol subversion 
• Protocol  – For information only. It is filled automatically according to the 

number of the used port.  
• Periodical Time Sync – Yes/No. If Yes, the device is synchronized with 

10 second period 
• Time Sync Forward – Yes/No. If Yes, the time synchronization which is 

received from upper channel, it is forwarded to the device 
• Control takeover valid – Yes/No. Determines if control of the device can 

be taken over (see 10.3.1 Ports Tab Card) 
• Signals blocking obj.addr.^ – The address of an object which 

determines blocking of all signals from that device. No signals are sent to 
control centre from that device 
*the object must be determined under a virtual device in objects table 

• Load XML – Load XML file with object data to the device (IEC 61850) 
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Adding devices 

By clicking on the  shortcut icon, a new device with default settings is 
added. It is also possible to add new devices with a right mouse click which 
makes the extended control menu to appear. 
 

 
 
 
 Add Devices dialog box appears.  

 
Set the Add Devices options:  

- Number of devices to add 
- Default settings or the 

device number from where 
the settings are derived  

- Copy Object Also 
 
Click the Add button. 
 

 
Removing Devices 
To remove a device, select Remove Devices  from the extended control menu 
or click on the shortcut icon. 
 

 
 
Select the range of the removed devices and click the Remove  or Remove 
All button. The selected device is also removed after the warning dialog when   

 is clicked. 
 
Clearing Devices 
To clear the Device Tab Card, select Clear from the extended control menu. 
A warning window always appears before removing all devices. 
 
 
Select Yes to accept or No to cancel the removal operation of the devices. 
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10.3.3 Objects Tab Card 
 

 
 
Figure 10.3.3 Objects tab card 
 
The first object of every device is used as the communication status signal of 
the device. If its value is “1” then communication with this device is broken. 
The object (first object) of communication status signal is not counted in the 
Objects  row of the Devices Tab  Card. 
 
Columns: 
Type  – Object’s type: digital input (DI), digital output (DO), analog input (AI), 
counter (CN) 
Sub Type^  – Object’s subtype for uplink.  
Sub Type v  – Object’s subtype for downlink.  
 
Subtypes of object can be selected. 

 

Object type Subtype ^ Subtype v  
DI – 
Digital input 

Single 
Double 

Normal 
Fallback 

DO – 
Digital output 

 Single                         Direct Execute 
Double            Select Execute 

AI – 
Analog input 

Normalized 
Floating point 
Step position 
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• Invert  – Object’s value will be inverted 
• Fn.code  – Function code on the IEC 60870-5-103 protocol 
• Info no . – Information number on the IEC 60870-5-103 protocol 
• Index  – Object index on the IEC 60870-5-103 and IEC 61850 protocol. 

It indicates the order number of the object in message types 3 and 9 of 
analog measurements. 

• Object.Addr ν  – Object’s downlink address  
• 61850 v –  61850 address (loaded from device’s XML file) 
• Object.Addr ^   – Object’s uplink address  

It is possible to send the same object to control centre with different 
addresses by creating several object with identical downlink addresses 
and different uplink addresses. 

• DB1 %Fs  – Deadband (% of full scale). If the value has changed less 
than the deadband then it is not spontaneously transferred. 

• DB2 %Fs – This is used instead of DB if the Crit.Min  and Crit.Max  
fields are used and the value falls within these limits. In case of offline 
(GSM) channel, if the change in value is bigger than deadband 2 (% of 
full scale) then a call to SCADA system is initiated.  

• Raw Min, Raw Max  – Minimum and maximum raw values of analog 
measurement (before scaling). 

• Scale Min, Scale Max – Minimum and maximum scale values of 
analog measurement. 

• Forb. Ports  – Uplink port to which the object’s value transfer is 
blocked. To select uplink ports, which should not be used for 
transferring these object values, double-click on the cell of the Forb. 
Ports column and select the corresponding ports from the window that 
has appeared. 

 
 

• Crit.Min %Fs / On Ev. Nr; Crit.Max  %Fs / Off Ev. Nr   
Crit.Min %Fs; Crit.Max %Fs – Minimum and maximum values in % 
from the full scale of analog measurements on which GW6 initializes 
communication (Fig. 10.5.1). If Crit. Max and Crit. Min do not have 
values, DB1 and DB2 are in use. If Crit. Max and Crit. Min have the 
value ‘zero’, only DeadB1 is in use. If the analog measurement value is 



AS Martem                          Data Concentrator TELEM-GW6  User Manual Rev. 7 / 2010 
 

 
Akadeemia tee 21G                         Tel: +372 639 79 79                             E-mail: martem@martem.eu 
12618 Tallinn                                  Fax: +379 639 79 80                                                 www.martem.eu 
Estonia 
 - 20 - 

between Crit. Min and Crit. Max, DB2 is in use. If the analog 
measurement value is out of limits, DB1 is in use. 
On Ev. Nr; Off Ev. Nr  – Corresponding event number used in SPA-bus 

• Forb. Calling  – Block object’s value transfer.  
• Ch. Nr. – Channel nr. for SPA-bus communication protocol 
• noFlags – If set to Yes, removes Invalid and Not Topical flags from 

object status. Used for objects, which statuses are not received with 
General Interval time (short circuit current, etc.) 

 
Adding Objects 

By clicking on the  button, a new device with default settings is added. 
Objects can also be added with a right click on the device tab card. After that 
the following extended control menu appears: 

 
 
When selecting Add Objects, the following dialog box appears: 
 

 
 
Removing Objects 

To remove a device, click the    button or select Remove Devices from the 
extended control menu. The following dialog box appears: 
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Hints 
• Repeated object addresses are shown on yellow background. 
• When leaving the Object Tab Card, all the objects are hidden. To see 

the objects on returning to Object Tab Card, use Expand All from the 
extended control menu that appears after a right click. 

 
 
10.3.4 Formulas Tab Card 
 

 
 
Figure 10.3.4 Formulas tab card 
 
Columns: 

• Type, Sub Type , Invert, Object Adr ^,  DB1 %Fs, DB 2 %Fs, Crit. 
Min %Fs, Crit. Max %Fs,  Raw Min, Raw Max, Scale Mi n, Scale 
Max, Forb.Ports  - as in Objects Tab Card  

• DO addr.  – Number of the digital output (1…16) in the TLM GW-IO 
device controlled by the result of this formula 

• Execution count – The number of control operations executed, if no 
feedback is received from control relay. Feedback must be determined 
in the formula 

• Delay – Delay in seconds 
• Forb. DO – The number of DO, which control is forbidden with the 

result of this formula 
• Formula – Formula string 

 
Editing formulas 
Formulas can be created between the values of analog and/or digital objects. 
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Referencing to object values 
To use the measurement object in the formula, insert an @ sign together with 
the object address up.  
Example: @101 points to the value of the object with an address to uplink 
101. 
 
Constants  
Constants can be used in formulas. 
Example: 1.1+2.2+3 consists of 3 floating point constants 
 
Brackets  
Brackets can be used in formulas to change the priority of the operation. 
Example: sqrt(@101/2+@102); (@201+@202+@203)/3 
 
Operators 
 
Oper.  Obj. type  Description  Sample  *Priority  
+ DI/AI Addition @101+3,2 3 
- DI/AI Subtraction @101-0,49 3 
* DI/AI Multiplication @101*2 2 
/ DI/AI Division @101/2 2 
^ DI/AI Exponentiation @101^2 1 
< DI Greater than @101<0,499 4 
> DI Less than @101>0,5 4 
sqr DI/AI Square sqr(@101*10) 0 
sqrt DI/AI Square route sqr(@101*10) 0 
and DI Logical conjunction @201and@202 5 
or DI Logical disjunction @201or@202 6 
xor DI Exclusive disjunction @201xor@202 6 
not DI Logical negation not@201 0 
dbl DI Converts 2 single 

digital inputs into a 
double signal 

@202dbl@201, 
where @202 – ON 
state signal 
@201 – OFF state 
signal 

7 

sin DI/AI  sin@301 0 
cos DI/AI  cos@301 0 
tan DI/AI  tan@301 0 
arcsin DI/AI  arcsin@301 0 
arccos DI/AI  arccos@301 0 
arctan DI/AI  arctan@301 0 
 
* priority determines the order of operations in the formula (the highest priority 
is 0) 
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Notes 
• All analog values should be scaled before making calculations; 

therefore, it is very important to fill the Raw Min, Raw Max, Scale Min, 
Scale Max  fields with Normalized values that are used in calculations. 

• After editing the formula, the program automatically validates this 
formula and shows the result in the status area. If the formula is 
incorrect, the background of the edited formula is changed to pink and 
an error message is displayed in the status area. 

• By clicking on the  button, a new formula row with default settings 
is added. 

By clicking on the   button, the selected formula row is removed. 
• Formula rows can also be added, removed or cleared by using the 

extended control menu like in the Object Tab Card. It appears with a 
right mouse click on the Formula Tab Card. 

 
 

 
 
To add a Formula, select Add Formulas , to remove a Formula, select 
Remove Formula and to clear all formulas, select Clear. 

• The formulas of DI type of objects can contain AI values and floating 
point constants. If the result of the formula is greater than 0, the value 
of the DI object is “1”; if the result of the formula is less than or equal to 
0, the value of the DI object is “0”. 

• < or > statement: if the statement is true, the value of the DI object is 1; 
if the statement is false, the value of the DI object is 0. 
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10.3.5 Status Tab Card    
 

 
 
Figure 10.3.5 Status tab card 
 
Status tab card presents the status of GW6 general configuration parameters 
and transfer statistics. 
Update  button is used to get information from the connected GW6 and it is 
displayed under Device Information. 
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10.4 Common menu item  
 
10.4.1 Analog Groups  
Interval groups are used to specify the time interval of sending analog input 
value to the remote control center when the value has changed less than the 
deadband. Interval groups can be added to analog input objects in the 
Configuration tool in the Objects tab (Analog group). 
 

 
 
10.4.2 TCP/IP Settings  
Used for GW6 to determine IP parameters.  
 

 
 
10.4.3 Timing Settings   
To determine device initialization timeouts, time zone correction and GPS. 
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10.4.4 Modem Settings   
Configure modem settings for modem callout communication mode (Port 2). 
 

 
 
10.4.5 Port Mirroring   
To determine 2 mirror groups (2 ports in each group). In case of mirrored 
ports, the data will be sent and received through both ports, but not 
simultaneously. If connection with first port fails, then connection will be 
established immediately using the second port of corresponding mirror group. 
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Notes for configuration: 
 

• If one GW6 is connected to another as sub-RTU (one collects data 
from another), then the configuration of sub-RTU can be remotely read 
and written through the main RTU using the configuration program. 

 
 
10.5 Configuration of connected I/O modules remotel y through the GW6 
 
For configuration of connected I/O modules through the GW6 the 
configuration redirection is used. There is the menu item  “GW6/RTA-A conf 
redirection” in main menu for opening the corresponding sub window. 
 

                    
 
For activating the redirection of configuration data insert the device no. from 
Devices tab of GW6/RTA-A configuration window and press the Activate 
button. After that the redirection notice is shown in the main window until to 
deactivation of it. 
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11. Configuration via FTP 
 

1. Make a configuration with GWS.exe and save it as binary file  
File > Save As > Binary file (*.bin) (gwSetup.bin) 

2. Connect to GW6 via a SFTP client (for instance WinSCP) 
3. Copy the binary configuration file (gwSetup.bin) to /root directory. 
4. Wait about 1 minute (this is unnecessary if reset is sent through the 

configuration program) 
5. Perform reset operation to Telem-GW6 device 
6. Wait until the device resumes to it’s normal operation state 
7. Configuration is complete 
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13. Communication Cables  
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 11.1 GW6 communication cables 
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Port RJ-45 pin layout. 
 
PIN  Ethernet 

port 
Port 1 RS-
422 

Port 2 
Isolated 
RS-232 

Port 3 
Isolated 
RS-232 

Port 5  
Isolated  
RS-485 

Port 6-13 
RS-232 

1 TX+  DSR  RX -  

2 TX- Time 
sync. puls 

CTS  RX +  

3 RX+ SGND GND SGND TX - GND 
4  RX+ RXD RXD* TX + RXD 
5  RX- TXD TXD SGND TXD 
6 RX- TX+ DCD SGND  GND 
7  TX- RTS    
8   DTR    
* GPS if supported 
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14. Firmware Update 
 
14.1 Loading firmware through Secure Digital (SD) M emory Card slot  
 
Updating firmware: 

1. Connect Secure Digital (SD) Memory Card to your computer 
2. Extract the compressed firmware update file (provided by Martem AS) 

to your SD Memory Card 
3. Disconnect the card from your computer 
4. Insert the card to Telem-GW6 SD Memory Card slot 

* SD Memory Card slot is located at the back of the device 
5. Perform reset operation to Telem-GW6 device 
6. Wait until the device resumes to it’s normal operation state 
7. Firmware update is complete. Remove the SD Memory Card and check 

if firmfare update was successful 
 
Checking results of the firmware update operation: 

1. Connect the SD Memory Card to your computer 
2. Open the folder you extracted earlier 
3. Check if the file “res.txt” is present and open it 
4. Check the state of installed files at the last part of the file 

*If the state of update files is OK - firmware update was successful 
 
14.2 Loading firmware via FTP  
 
Updating firmware: 

1. Connect to GW6 via a SFTP client (for instance WinSCP) 
Login as ftpuser (password is provided by Martem AS) 

2. Extract the compressed firmware update file (provided by Martem AS) 
to your computer and copy it to ftpuser directory 

3. Wait about 1 minute (this is unnecessary if reset is sent through the 
configuration program) 

4. Perform reset operation to Telem-GW6 device 
5. Wait until the device resumes to it’s normal operation state 
6. Firmware update is complete.  

 
Checking results of the firmware update operation: 

1. Open the ftpuser directory  
2. Check if the file “res.txt” is present and open it, if update fails “err.txt” 

file is created with some description of error. 
3. Check the state of installed files at the last part of the file 

*If the state of update files is OK - firmware update was successful 
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15.  Notes 
 
• If not stated otherwise on the individual pages of this document, AS 

Martem reserves the right to make modifications. 
• Although the contents of this publication have been checked for 

conformity with the hardware and software described, we cannot 
guarantee complete conformity since errors cannot be excluded. 

• The information provided in this manual is checked at regular intervals 
and any corrections that might become necessary are included in the 
next releases.  

• Any suggestions for improvement are welcome.  
• The contents of this manual are subject to change without prior notice. 

 
 


